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1. GENERAL OVERVIEW

1.1. Software Installation

The A434L Viewer runs on the Windows OS-based PC.

1.1.1. System Requirements

System requirements of A434L_Viewer PC program are as follows:

[Table 1] System Requirements of A434L_Viewer PC Program

Classification Specifications
Operating Windows XP SP3 or Windows 7
System recommended

Processor with 300 MHz or higher, 233 MHz
in minimum

CPU Intel Pentium/Celeron series, AMD
K6/Athlon/Duron series or other compatible
processors

RAM 128 MB or higher (64 MB in minimum)

HDD 1.5 GB (available space)

1.1.2. Install Process

As based on the .NET Framework 3.5, you must install .NET Framework 3.5
when installing the A434L PC GUI Program.

X Caution, Installation of .NET Framework 3.5 requires Internet connection.



[Installing A434L_Viewer]

]
Double-click the Setup.exe # icon to start the install program.

i A4341_Viewer

Welcome to the A434L_Viewer Setup Wizard

The installer will guide you through the steps required to install 24341 _Viewer on your computer.

WARNING: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Cancel ¢ Back

[Installation 1] Double-click the Setup icon and the installation program is
executed as shown in the above figure,

In the [Installation 1] figure, click the ‘Next’ button to move to the next step.



i A1341_Viewer

Select Installation Folder

The installer will install A434L_Viewer to the following folder.

To install in this folder, click "Nest". To install to a different folder, enter it below or click "Browse"".

Folder:
|C MProgram FilesWQSHY A434L _Viewert [ Browse... ]

Disk Cost...

Install 4341 _Viewer for yourself, or for anyone who uses this computer:

) Evervone
() Just me

[ Cancel ] [ < Back ] | Newt> |

[Installation 2] Setting the installation path

The [Installation 2] figure shows the installation path of the Setup file. Do
not modify the path but click the ‘Next’ button to move to the next step.



& A4341 _Viewer

Confirm Installation

The installer is ready to install 4434L_Viewer on your computer.

Click "Next" to start the installation.

[ Cancel ] [ < Back ] uexn |

[Installation 3] Before starting installation

Click the ‘Next’ button to start installation.



& A4341 _Viewer

Installing A434L_Viewer

A434L_Viewer is being installed.

Please wait...

[Installation 4] Installation in progress



i Ad341_Viewer

Installation Complete

A434L_Viewer has been successfully installed.

Click "Close" to exit.

Please use Windows Update to check for any critical updates to the NET Framework.

[Installation 5] Completion of A434L_Viewer installation

Installation of A434L_Viewer has completed. Click the ‘Next’ button to exit
the installation program.

[Installing DotNetFrameWork 3.55P1]

In the Window 7 operating system or the higher, DotNetFrameWork 3.5.1
has been installed by default; you can skip the following procedure.

e

Double-click the dotnetfx35setup.exe * icon to execute it.



@B  Setup is Ioading installation components.
oy This may take a minute ortwo.,

[Installation 6] Preparing for installation of .NETFrameWork3.5

= Microsoft NET Framework 35 591 Setup =EEd
Microsoft
Welcome to Setup .Net Framework

Be sure to carefully read and understand all the rights and restrictions described in the
license terms. You must accept the license terms before you can install the software,

|

3
MICROSOFT SOFTWARE SUPPLEMENTAL l

B -

Press the Page Down key to see more text.

1@ I have read and ACCEPT the terms of the License Agreement
(7)1 DO NOT ACCEPT the terms of the License Agreement

[] send information about my setup experiences to Microsoft Corporation.
Details regarding the data collection palicy

Download File Size: 59 MB
Download Time Estimate: 2 hr 25 min (56 kbps)
15 min {512 kbps)

[ Install > ][ Cancel ]

[Installation 7] Installation of Microsoft .NET Framework 3.5

Choose ‘I have read and ACCEPT the terms of the License Agreement’ radio
button and then click the ‘Install’ button to start installation.
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7 Microsoft INET Fremework 3.5 SP1L Setup e

Download and Install Progress g n_et Fra mewo rk
Installing:

j/ Download complete. You can now disconnect from the Internet.

[Installation 8] Microsoft .Net Framework 3.5 DownLoad Complete

Download the .Net Framework3.5 and installation is automatically executed
when the download completes.
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_ Microsoft NET Framework 3.5 SP1 Setup = s

Setup Complete .Net Framework

Microsoft .NET Framework 3.5 SP1 has been installed successfully.

d) Itis highly recommended that you download and install the latest service packs and security
updates for this product.

For more information, see Windows Update

[Installation 9] Completion of .NET Framework 3.5 installation

When Microsoft .NET Framework3.5 has been installed, you are prepared
to use the A434L_PC_GUI program.

1.2. Running Program

Double-click the A434L_Viewer ﬂ icon on the Desktop and the
program will start as shown in [Figure 1].
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[Figure 1] A434L PC Program Execution Screen

When executing the program for the first as shown in [Figure 1], you are
not connected with A434L. To load the Trace from the equipment, you need
to connect to the equipment as follows:

1.2.1. Terminal IP Setting

To run the program, you must connect your PC to the equipment via
Ethernet and configure the communication environment between the
equipment and the PC.

Press the System key from the Menu keys on the right side of the
equipment and the screen will be switched to the System screen as shown
in the following figure:

13
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[Figure 2] Network information and Instrument Setting Key on the System
screen of the A434L equipment

Choose the ‘Instrument Setting’ button from the menu buttons on the
right side of the screen and then move to the submenu.

DateTima >

Slesp Tima

[Figure 3] System screen of the A434L equipment
14



From the submenu, choose the ‘LAN’ button and then the ‘IP Address’
button to enter the IP address.

[Figure 4] Setting IP, Sub Net Mask and Gateway in the given order

Set ‘Net Mask’ and ‘Gateway’ in the way same with IP setting.

1.2.2. PCIP Setting

After setting the IP address of the equipment, run the PC program and set
the IP address of the equipment on the program.

As shown in the following figure, choose [Setting] - [Host IP] from the
Menu of the PC program.

15
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[Figure 5] Menu Bar [Setting] - [Host IP]

In the following IP setting window, enter the IP address of the equipment,
which has been set at 1.2.1, in the ‘Server IP’ field.

[Figure 6] Enter the IP address which has been set in the A434L
equipment.
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1.2.3. Connect & Disconnect

[Connect]

By completing the process of [Figure 6], you are prepared to connect to the
equipment. Click the ‘Connect’ button to connect to the equipment.

When you are connected successfully, the status displayed at the right
bottom of the screen is changed to ‘Connect’ as shown in the following

figure.

[Figure 7] ‘Connect’ displayed on the right side of the status bar

17



[Disconnect]

To disconnect from the equipment, click Setting -> Host IP on the top Menu
bar and then click the ‘Disconnect’ button in the IP Setting and Connection
window; your PC is disconnected from the equipment and ‘Disconnect’ is
displayed at the status bar.

1.2.4.Error Message

Some errors may occur with the following error message window while
connecting to the equipment. You can fix the errors as follows:

When the IP address has been set correctly or when you
have tried to connect to the equipment while the PC
cable is not connected to the equipment

[Figure 8] Connection Error 1

ﬁ Check the IP setting and cable connection.

18



When the cable has been broken or the equipment has

State: . .
stopped while you are connected to the equipment.

[Figure 9] Connection Error 2

Check whether the equipment has stopped or whether

How to fix: the cable has been broken.

19




1.3. Main Window Form Description

The main window of A434L PC Program consists of Menu Bar, Tool Bar,
Property window form and Trace window form and the features are as

follows:

et | VEWH CAA |
na

[Figure 10] Menu Bar and Tool Bar on the top, Property Window on the left,
Trace Window at the center

1.3.1. Menu Bar

The main Menu Bar of A434L PC Program provides various features
including connection, configuration, trace load and band & cable edit as
follows:

20



[Table 2] Menu Bar

Menu Features
File Open, Save as, Export, Print, Exit
Load Load Current
Edit Trace Copy, Trace Paste
View Tool Bar, Status Line, Property Window
Utility Band Edit, Cable Edit
Setting Host IP, Default Trace Setting, Misc, User Info, Prefix,
PostFix
Windows Cascade, Tile
Help Contents
1.3.2.Tool Bar

The A434L PC Program provides icons for some basic features.

NI

From the left side, the icons are Open, Save, Print, Capture and Help.

1.3.3. Property Window Form

The Property window form allows you to select the trace information in the

21




Trace Window and the contents to be displayed at the bottom of the Trace
window. It shows information required for each mode, such as VSWR, DTF
and Cable Loss. As shown in [Figure 10], check each O with v' (M) to display
the checked items at the bottom of the Trace window form.

When you open several Trace window forms, you can enable the Trace
window by selecting the Form in the Type Frame list.

1.3.4. Trace Window Form

The A434L PC Program displays the result of the moment when you have
executed Load, not the continuous sweep data. The loaded data supports
various modes including VSWR, DTF, Cable Loss, Return Loss and Smith
Chart and can be converted to various formats such as VSWR and Return
Loss in each mode. In addition, features such as Marker and Limit Line are
available.

22
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2. CONTROL

2.1. Menu Bar Controls
This section describes the Menu Bar features of A434.
2.1.1. File

The File menu allows you to save or open the data read from the A434L to
CSV or JPEG image. It also provide Print feature to print data as a report
format.

Load
COpen

Edit  “iew LUtllity  Sett

Save as

Export » to CSW

Print to irnage
Euit

[Figure 11] File Menu

Open - Opens the saved Trace CSV file and displays it as Trace
window form.
- Only the CSV file which has been saved with the ‘Save As’
feature can be opened.

Saves the information loaded from the A434Las a CSV file.

- All information displayed on the Property window (Load
Date, Trace Point, Span, Start & Stop Frequency, Display
Mode, etc.) are saved in the CSV file.

- The file name is “Trace current time.csv.”

Save as

24



Export

Saves as a CSV or JPEG image.

- Saves only the VSWR, DTF, and Cable Loss Trace values
corresponding to the Trace frequency range and mode.

- The file name is “Current current time.csv.”

- Toimage captures and saves the current screen as a JPEG
image file.

- The file name is “lmage current time.jpg.”

Prints the program window.
The printed screen is as follows:

40 ommEE

[Figure 12] Preview Print
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2.1.2.Load

The Load menu loads data from the equipment. The Load Current button is
enabled only when the connection status is Connect.

File | Load | Edit  “iew Uil File | Load | Edit  “Wiew Ut
s [2 =7 Load Current

[Figure 13] Disabled button (left), Enabled button (right)

2.1.3. Edit

The Edit menu can be used only when the PC has been connected and Trace
has been loaded.

Edit [ view Utilty S Edit | view Uity
| Trace Copy |

Trace Paste

[Figure 14] Disabled button (left), Enabled button (right)

Saves the Trace data of the selected Trace window form
in the buffer.

- Copies the Trace data saved with the Trace Copy feature
to another Trace window form.

Trace Copy

Trace Paste

26
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[Figure 15] Trace Paste Screen

The blue trace in the above figure is the main trace of the activated form.
The sky-blue trace is the trace copied and pasted from the trace in the Form
1 with the ‘Trace Copy & Paste’ feature.

2.1.4. View

The View menu allows you to set whether to enable or disable the Tool Bar
under the menu bar of A434L PC Program, the Status Line under the
program window, and the Property window form. You can set it by using
the check box in front of each item.

YMiew | Lillity  Seting  Windows
i~ Tool bar

« | Status line

v | Property Windows

[Figure 16] Enabled Items
27



2.1.5. Utility

The Utility menu allows you to load the Custom Band List and the Cable List
of the A434L equipment and to create and save the Custom Band List and
the Cable List to the equipment. You can save and load the list to the PC as
a text file.

[Band List Edit]

1. ADD & DEL =» Adds the band information or deletes the selected band.

= )
o2/ frmBandfist B[]
Band Name Start Frequency [MHz] Stop Frequency [MHz]
Test Band 100 = 500] = | peL
Band Name Start Frequency [MHz] Stop Frequency [MHz]
Load from PC | ‘ Saveto PC ’ ‘ Load from device l ‘ Save to device

[Figure 17] Band ADD & DEL of Band EditEnter the appropriate

information in Band Name, Start Frequency and Stop Frequency and then

28



click the ‘ADD’ button to add the band to the list at the center.

o frmBand s oo
Band Name Start Frequency [MHz] Stop Frequency [MHz]
Test Band [100 =] 500 ) DEL
Band Name Start Frequency [MHz] Stop Frequency [MHz]
Test Band 100 500
< m | 3
Load from PC ’ ‘ Saveto PC ' l Load from device ‘ ‘ Save to device I

[Figure 18] Band added to List

2. Load from device = Loads the Custom Band list from the equipment.

29



I ‘é?.’;; N ’ﬂ:ﬁé '-m-\,,@," @ -
Band Name Start Frequency [MHz] Stop Frequency [MHz] ADD
oth US & Europe 2400 ] 2484 B | DEL
Band Name Start Frequency [MHz] Stop Frequency [MHz]
CELLULAR UP 824 849
CDMACHINA UP 872 915
Blue Tooth US & Europe 2400 2484
< I »
Load from PC ‘ ‘ Saveto PC ‘ ‘ Load from device ’ Save to device

[Figure 19] Loading A434L Custom Band List

Click the ‘Load from device’ button to list up the items included in the
‘Custom Band List” of the equipment at the center as shown in the figure.

3. Save to PC = Saves the band list displayed in the Band Edit window as
a file to the PC.
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Band Name Start Frequency [MHz] Stop Frequency [MHz]
| I 2

Band Name Start Frequency [MHz] Stop Frequency [MHz]
CELLULAR UP 824 849
CDMA CHINA UP 872 915
Blue Tooth US & Europe 2400 2484
< m 3

Load from PC Saveto PC Load from device Save to device

[Figure 20] Saving items in List to PC as a text file

Click the ‘Save to PC’ button and the following window appears:
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Documents library A -
nctudue 1 e st Al
MHere Dove et Toee
o Band w0407 01 AM-3L32 IO LELI AN Tt Devieny

CELLLUR e
COMA O 9 m

B Toom LS § Tumge e

o oy M i =l
;......... O] (e ]
o R e P

[Figure 21] File name: “BandList current time.txt”

As shown in the figure, the file format is txt. File and the default file name

is the time when the file has been saved.

4. Load from PC = Loads the Band list file saved in the PC.
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Band Name

Start Frequency [MHz]

Stop Frequency [MHz] ADD

I

| 4 | DL
Band Name Start Frequency [MHz] Stop Frequency [MHz]
CELLULAR UP 824 849
CDMACHINA UP 872 915
Blue Tooth US & Europe 2400 2484
1 m. 3
Load from PC Saveto PC Load from device Save to device

[Figure 22] Loading Band List text file saved before

Click the ‘Load from PC’ button and the following window appears to select

a file as shown below.
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[Figure 23] Band Edit - Load From PC

Select a file and click the ‘Open’ button, and then the file is listed up in the
Band Edit window.
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Band Name Start Frequency [MHz] Stop Frequency [MHz] E ADD ;
woth US & Europe |2400 =S| 2482 = DEL
Band Name Start Frequency [MHz] Stop Frequency [MHz]
CELLULAR UP 824 843
CDMA CHINA UP 872 915
Blue Tooth US & Europe 2400 2484
ZHi ™ i J >
[ Load from PC ] l Saveto PC l [ Load from device ] [ Save to device ]

[Figure 24] File listed up in the window

5. Frequency Range = The band range is 5 MHz~ 4,000 MHz. When the
input value exceeds the range, an error message popup appears.
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Wl frmBand fist

Start Frequency [MHz] Stop Frequency [MHz]

i

Band Name
— H e =
Band Name Start Frequency [MHz] Stop Frequency [MHz]
Too big range! batter Start frequency than stop frequency
4 1]
l Load from PC } l Saveto PC l l Load from device } l Save to device l

[Cable List Edit]

[Figure 25] Band Range: 5 MHz ~ 4000 MHz

The Cable List Edit features are same with the Band List Edit features. Enter
the list information and click the ‘ADD’ button to add the list. To save or

load the list, use the Load button and the Save button as shown below.
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B frmm—cabila list

Cable Name Wilocity Loss 10He Loas 20HE m
TEET CAHLE 0.09 - 010 = 016 - DEL
Cabde Narmd arlodity 1GHz [4B] 2GHz [4B]
TEST CaBLE 0,08 i) 0ie
Liad fromm PC | | Save lo PC | ] Load Irorm device Save o device

[Figure 26] Cable Edit Features

The list to be added to the Cable List should be within the following range:
Velocity 0~1, 1 GHz & 2 GHz Range 0~3.

When a list exceeds this range, an error message popup appears.

=X (S ==

Velocity Range is 0~1 1GHz Range is0~3 2GHz Range is0-3

[Figure 27] Error message displayed when out of the range
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2.1.6. Setting

As well as the ‘Host IP’ feature to connect with the A434L, the Setting menu
provides the ‘Default Trace Setting’ feature to set the thickness and unit of
trace, the ‘Misc feature to set the font, the ‘User Info’ feature to enter the
user information, and the ‘Prefix/Postfix’ feature to set the prefix and postfix
of the Trace form chart. Description on the ‘Host IP’ feature is excluded here
as it has been described in Section 1.2.

[Default Trace Setting]

Setting |:| |§| E|

Default Chart | Misc | User Info | Prefix/Postiix |

FlotiLimit Line ¥Width Footer

(& Thin {Default) |VSWR v

O Thick

T
>

m
Hald

Diate

Time

Model Hame
Firmware Version
Wiewer Warsion
2]

CAL Status

CAL Date

AL Tirme

Trace Average
Diata Paint v

Mesurement Linit

P RENEEOROREER

’ OK ][ Cancel ]

[Figure 28] Tab key on the top of setting window can be used.
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The ‘Plot/Limit Line Width’ allows you to set the trace line thickness.

[E 3] Setting Trace line thickness

Plot/Limit Line Width

Thin(Default)

Thin line (Default)

Thick

Thick line

® Load Form|

700
2041
1982
182
1863 F
1
785
1686 E
1626
1567 E

1508 i

™0 gy

D 20000
LRI

Dwis Powst - 2001

Ldmiid
BN

Tow 45X
i, Sewim O
Bori Uara  Comie™

currend { VEWR CAA )

VIR

r= i)

omw

N e e
el e o m W

T recmncy

Bodai
THOG

bo|ow Bl
nie Fu i)

Mocel Haeme  ad i, Femawrs Yorwae 013 Wemw Vepaon 007
CiL Dwie 20000101

Sy 500

Cl, Tim: (135008 Trace dowrngs 1790

Bt Lo - THEA Shvw Lewwl ! DIFF

[Figure 29] Trace Width Thick
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The ‘Measurement Unit’ allows you to select the data unit of the DTF mode.

[Table 4] Unit conversion

Measurement Unit

Meters(Default) In meter
Feet In feet

The ‘Footer’ drop-down box allows you to set the list to be displayed in the
Property window when loading the trace. Select the mode from the drop-
down box. In the Item List, choose the list to be displayed at the mode.

[Misc]

It allows you to change the font of the Trace window.
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[Figure 30] Changing Font

[User Info]

It allows you to enter the user name and the company name. The user
name and company name entered will be automatically entered in the
Report window.



Digfayhl Chart| Mz | Bser B8 | Predu/Pogtin

Comgany

GE Insrumin

LFsdr

Teetar

Ok, | [ Cameni |

[Figure 31] Automatic Insertion of User Info to Report
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™ frm _report

Title

User [Tester Date  |2014-05-27-14-36 |

Site Infarmation | |

Test Purpose
Result
Rernark
Comapany G3 Instrument |
[ Prnt | [ Cancel |
[Figure 32] Report window with User Info
[Prefix/Postfix]

It allows you to add a prefix and postfix to the sub title in the Trace
window.
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B8 Setting

| Default Chant | Misc | User Info | Prefiz/Postfix |

Prefix

|Prefix Test

Ifyou put characters here, then itwill be attached at the beginning of
subtitle of all graphs that shall be opened fraom now on automaticalky
Ex) Prefix + Sub Title

Fostfix

FPostfix Test

Ifyou put characters here, then it will he attached atthe end of
=ubtitle of all graphs that shall be opened fram now on automaticalky
E:) Sub Title + Paostix

[ 0K ] [ Cancel

[Figure 33] Prefix/Postfix of sub title
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[Figure 34] Added Prefix and Postfix (in the red rectangle)
2.1.7. Windows

The Windows tab allows you to change the shape and size of the Trace
windows. The following figure shows the setting screen.

[Cascade]
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[Figure 35] Cascade

[Tile] - [Vertical]

[Figure 36] [Vertical]
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[Tile] - [Horizontal]

x| VEWICAA |

T = S e = UL L R 5
- rili — v e
[ e e T .

[Figure 37] [Horizontal]

2.1.8. Help

G5l

AABAL Fiewer .07
Fhane = RI-1EI-BET
s © GE Inalvumesis Ga.,0ld.

M. Glipe-ra Flimon-ghl, Nas-gu,
Inchens, Esres

TIF Cacda & anT-And

L wre . gninal rumenl .con

Teihnleal daslslancs ¢ |waleles|nsl rieend . cee

Cowyrighl [c) G Inslrusenln Ga. Lld.

i

[Figure 38] Help
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The Contents item in the Help menu displays the program information and
the GS Instrument information.

2.2. Trace Window Form Controls

The Trace window displays the trace based on the information received from
the A434L equipment. In addition, it allows you to analyze the displayed
trace by using various features such as Convert, Limit Line, Marker & Delta
Marker and Zoom. Right-click on the Trace window form to view various
feature menus.

2.2.1. Convert

The Convert feature converts the mode: VSWR, DTF, Cable Loss and Smith
Chart. When executing the Convert feature, the format is not loaded newly

but converted from the current format to another format. [VSWR]

¥ Litawil Faipml

eurrond | VSWH CAM )

Ee

0
bR
Convart .l
1R il iy Robiniat » o
. Wgnal * Cablalass
3 i m LD St Chan
e E Neve Sose
2 %
§ ok Srww
& E Teom .
s -E Lt Lins
Hnph Tl
e E
3 ]
EE =
557
[ [ S T P RS S S S B D
i m =0 0 w0 T T Mime  timE T 30 )
[
s 2000 - A W ool Meme  adla W i 01V Cal Do 4
CAL Do FEEGLA A Tomw 01 208 wor Sewrwpw 780D wan Pt 01 Bt ligmw Lonhe
e B0 Lot i 0k i it FF

[Figure 38] When A434L is VSWR Format
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[DTF]

currmnl { DTF CAA)
Ty n
e
(e
"
L] -]
% s
e
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[Figure 40] Converted to DTF Format
[Cable Loss]

currenl { Cablo Loss CAA §
el

o
amn
1ol E
T4 =
18
-
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FE -
188

3

B [ e T . eI
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[Figure 39] Converted to Cable Loss Format
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[Smith Chart]
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[Figure 40] Converted to Smith Chart Format

[Smith Chart]

The Smith Chart window provides additional analytic features. Like the Trace
window, right-click on the Smith Chart window and the Smith Marker menu
appears as shown in [Figure 43].

50



R T ]
Tengeam

mEE
fi w e o v 1 L

e mm= Vi S ™8 Ve =y 27 B e
e am= e

[Figure 41] Right-clicking on Smith Chart to display Smith Marker Menu

Click the ‘Smith Marker button and the Smith Marker window appears as
shown in [Figure 44].

By using the Up/Down button at the Data field to change the data point;
values of the selected data point are displayed in the following fields and
the red marker moves to the data point on the Smith Chart.
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[Figure 42] Smith Marker providing Impedance, VSWR and Return Loss

2.2.2. Display Mode

The Display Mode allows you to convert the mode from VSWR mode or DTF
Mode to Return Loss Scale View.
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[Figure 43] Display Mode
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[Figure 44] [VSWR] - [Return Loss]
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[Figure 45] [DTF] - [Return Loss]

2.2.3. Marker

The Marker feature provides a marker to move on the trace; you can read

the trace value by moving it,
In addition, the Delta Marker feature allows you to read the difference

between the marker and the Delta marker.

[Marker]
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[Figure 46] Enabled Marker: Up to 10 markers can be marked and the
marker value is displayed on the top of the Trace window
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[Selecting and Moving Marker]
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[Figure 47] Select a marker and click and drag the X symbol to move

Click the marker image to select it. Place the mouse pointer on the X symbol
at the marker image and then the mouse pointer is changed to the cross (+)
symbol.

While the mouse pointer is the cross (+) symbol, click and drag the marker
image to move. After moving it, the marker value is updated.

[Move to Max, Move to Min, Move to Center]
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[Figure 50] Move to Max

The Move to Max feature moves the marker to the maximum value position
of the trace.
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[Figure 48] Move to Min

The Move to Min feature moves the marker to the minimum value position
of the trace.
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[Figure 49] Move to Center

The Move to Center feature moves the marker to the center of the span
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[Figure 50] Set Delta

The Set Delta feature allows you to calculate the difference between two
positions by using a marker and a Delta marker.

1. Select a marker and then click the Set Delta button on the Marker
menu; the Delta marker is displayed on the selected marker
position.

2. Drag the Delta marker or the marker with the mouse and move it
to calculate the difference between the two positions.

3.  While using the Delta Marker feature, the data value displayed on
the top of the Trace window is the difference between the two
markers.

[Set Frequencyl]
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[Figure 54] Set Frequency

The Set Frequency feature allows you to move to the marker position by

entering the frequency value directly.

[Marker All Off]

The Marker All Off feature disables all marker features enabled.

2.2.4. View Legend

The View Legend feature displays each trace on the right top as a legend

when several traces are used.
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[Figure 51] View Legend displaying various trace on the right top as a
legend

2.2.5. Reset Scale

The Reset Scale feature resets the scale or zoom applied to the screen to the
initial status when the Scale feature or the Zoom feature has been used.

2.2.6. Scale

The Scale feature allows you to adjust the scale of the Trace window within
the scale range loaded at the initial step.
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[Figure 52] Scale in VSWR or DTF Mode

Scale is allowed within the scale range of the Trace window loaded first.
When the specified range is exceeded, a warning message is displayed.

63



cutranl { VSWR CAA |
o
1363
150
1445
.
i1
1867 /ﬂ\
Nl T N TR R PR PR, = S
o mem  mem mm
e 300053 T 232831 ikl AL VoV E) AL S O
Al D SOOEIOT Gl Tenw O17808 | [Te—— TR e — [T —
p— e [——

[Figure 53] Applying Scale
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[Figure 54] Scale at Return Loss or Cable Loss mode

Note that the smallest number indicates the largest value in the Return Loss
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mode or the Cable Loss mode.

2.2.7. Zoom

There are two ways to zoom in; one is the Zoom button displayed by right-
clicking and selecting the Zoom menu and the other one is to drag to the

Trace window directly.

[By Right-clicking]
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[Figure 55] Zoom feature by right-clicking

Directly drag the part with the mouse to zoom it.
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[Figure 60] Zoom in by dragging with mouse

As shown in [Figure 60], drag the desired part with the mouse.
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[Figure 61] Zoomed-In with mouse drag
[Zoom Out]

There are two ways to zoom out; one is to click [Zoom] and right-click the
[Zoom Out] menu with the mouse and the other one is to click the Zoom
Out button in the red circle of the Trace window as shown in [Figure 61].

2.2.8. Limit Line

The A434L PC Program provides the Limit Line feature. When the Limit Line
feature is enabled, a red vertical line is displayed on the Trace window to
divide the screen in half. The trace in the upper half is colored in red.
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[Figure 56] Limit Line

The Limit Line feature allows you to move the line up and down by dragging
with the mouse and the color is changed and updated whenever the line is
moved.

In addition, the user can view the Limit Line value at the bottom of the
Property window form or the Trace window.

2.2.9. Graph Title

The Graph Title allows you to set or change the title and sub title of the chart
in the Trace window.

Click the Graph Title button and a window appears as shown in [Figure 63].
The Main Title is to set or change the main title and the Sub Title is to set or
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change the sub title.
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[Figure 57] Graph Title

Both of the main title and the sub title are set to TEST.
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[Figure 58] Result after setting

2.2.10. Report

The Report feature displays the report form including the current Trace
window image captured and prints the report form as a report.

Right-click and click the Report button to display the report form window as
shown below.

The User and Company fields are automatically filled when the information
is saved in [Setting] - [User Info]

(see 2.1.6 Setting).
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[ Print ][ Cancel ]

[Figure 59] Easy creation of report with Report feature

After completing all fields, click the Print button to print the report
window including the trace image as shown below.
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[Figure 60] Printing Report with Trace image
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